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Getting Started with BarTender
BarTender® software enables organizations around the world to improve safety, security, efficiency
and compliance by creating and automating the printing and control of labels, barcodes, RFID tags,
plastic cards and more. BarTender gives you the tools to easily and efficiently design labels and
templates, configure and connect to data sources and business systems, and launch print
commands from any system, OS or device.
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Installation

Choosing What to Install
BarTender includes a variety of applications that provide a level of power and flexibility not available
in any other design and printing software package. The applications available to you depend on the
edition of the BarTender that you purchased.

The following table defines the applications included in each edition of BarTender. If you choose a
typical installation, these applications will be installed by default with BarTender.

Basic Professional Automation Enterprise Automation
BarTender Designer ✔ ✔ ✔ ✔

Print Station ✔ ✔ ✔ ✔

Batch Maker ✖ ✔ ✔ ✔

History Explorer ✖ ✖ ✔* ✔

Printer Maestro ✖ ✖ ✔* ✔

Reprint Console ✖ ✖ ✔* ✔

Integration Builder ✖ ✖ ✔* ✔

Librarian ✖ ✖ ✖ ✔

Print Portal ✖ ✖ ✖ ✔ (only when specified)

* Limited functionality in Automation edition

Automation Editions (Automation and Enterprise Automation)
If you purchased an Automation edition of BarTender, you will also need to install a single copy of
Seagull License Server (SLS) on your network in order to enforce licensing. Without this application,
BarTender will run in demo mode, altering your print output from your intended design.

l If you are running only one copy of BarTender, SLS and BarTender are usually installed on the
same computer. On the installer, simply check the box for Seagull License Server to install
both applications.

l If you are running BarTender on multiple computers within your environment, SLS is installed
on ONLY one computer. This computer, typically a server, must be accessible across your
network by all installed copies of BarTender. When running the installer, you have the option
to install Seagull License Server Only. Use this option if the computer (or server) running SLS
will not also have BarTender running on it. If you choose to also install BarTender, run the
installer and check the box for Seagull License Server to install both applications. All other
installations should not include Seagull License Server.

If you will be creating your own custom applications to run and manage BarTender, the BarTender
.NET SDK is also available for installation. This collection of APIs let your applications automatically
perform all of the data-retrieval and high demand label printing tasks that BarTender itself performs.
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Installing BarTender
BarTender is available in two versions: 32-bit and 64-bit.

l If you have a 32-bit operating system (OS), you must install the 32-bit version of BarTender.

l If you have a 64-bit version ofWindows, you may install either the 64-bit or 32-bit version of
BarTender. The 64-bit version is recommended, but you may need to install the 32-bit edition
if you are using certain OLE DB or ODBC database drivers, or if you need to develop a 32-bit
application using the SDK. Please see the white paper 32-bit and 64-bit BarTender for more
detailed information.

Before installing BarTender, verify that you have the following easily accessible:

l Your Product Key Code (PKC) (if you purchased a license of BarTender)

l The correct 32-bit or 64-bit BarTender installation package, available on the BarTender DVD
or downloaded from our website at http://www.seagullscientific.com/label-
software/barcode-label-printing-software-download.aspx

In addition, determine which Companion Applications and additional features you wish to include
with the BarTender installation. For more information about these applications, refer to Choosing
What to Install.

To install BarTender and Companion Applications (Basic and Professional Editions)

1. Double-click on the BarTender installation package.

2. If asked, pick your desired language for the installer and click OK.

3. On the initial installer screen, click Next.

4. Read and accept the license agreement, then click Next.

5. Select the edition of BarTender you have purchased, then click Next.

6. To complete your installation of BarTender and the Companion Applications included with your
edition, click Install.

To install BarTender and Companion Applications (Automation Editions)

1. Double-click on the BarTender installation package.

2. If asked, pick your desired language for the installer and click OK.

3. On the initial installer screen, click Next.

4. Read and accept the license agreement, then click Next.

5. Select the edition of BarTender you have purchased, then click Next.

6. Select your desired installation scenario:
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l To install the entire BarTender Suite withoutSLS, click Next.

l To install SLS alongside the entire BarTender Suite, check the box for Seagull License
Server and click Next.

l To specify which applications to install, check the box Specify advanced installation
options and click Next. Check the applications you wish you install. Optionally, specify an
alternative installation location on your computer. Click Next.

7. On the Service Configuration page, specify a user account for the services used by
BarTender. Click Create a New User Account or Select an Existing User Account to change
the default settings. Once your changes are made, or to keep the default settings, click Next.

8. On the Review Options screen, verify that the components you want are being installed. To
complete your installation of BarTender and the selected Companion Applications included
with your edition, click Install.

Installing BarTender Print Portal
BarTender Print Portal is a web-based application that provides an interface for selecting and
printing BarTender documents. A single web server "hosts" Print Portal, making its documents
accessible to other computers, tablets, and even mobile devices over the internet. Users in your
company can print documents simply by going to a website and selecting the document they want to
print.

Print Portal must be hosted on a computer running the following software

l IIS

l ASP .NET

l BarTender (Enterprise Automation or Trial edition)

All client devices must have access to a web browser.

The BarTender System Databasemust be set up for Print Portal to
function. For more information, refer to Setting Up the BarTender
System Database.

Enabling Authentication

Administrators can configure Print Portal so that users have log in using the Windows accounts.
With authentication enabled, only users with the Administer permission in Administration
Console will be able to change Print Portal's administrative settings. Authentication is enabled in
the Administrative Setup settings of Print Portal.

If you wish to further secure your environment, you can choose to authenticate users over
HTTPS. This requires that a security certificate and HTTPS binding is configured for the Print Portal
website in IIS. Refer to the BarTender Print Portal help system for more information.
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For Designers and Print Operators
Whether you are designing or printing items, the BarTender interface is powerful and using it can be
intimidating for new users. This chapter is written to get you started with the most basic tasks in
BarTender, including creating, designing, and printing items.

Creating a New Document
Depending on how BarTender is configured, one of three things will happen when you select New
from the File menu or click on the main toolbar:

l The New Document Wizard opens, letting you manually specify the size and shape of your
design area. (Default behavior)

l A blank template appears on screen, with the size and shape defined by the settings of the
default printer on your computer.

l A copy of an existing document opens.

The design area on screen should match the dimensions and shape of the actual items that you are
printing on. This verifies that what you create on screen is the same design that will print on your
items. These settings, along with settings such as the number of items on a page, the orientation of
your design, or the size of the gap between multiple items are defined using either the New
Document Wizard or the Page Setup dialog.

Each on-screen design area is configured to a printer stock on a specific printer. If you
need to change printers or media, BarTender will attempt to automatically change the
dimensions of the design area to match the new printer or media. Due to the fact that
different printers support different sizes ofmedia, the positioning of your objects may no
longer fit on your item, and you will need to either alter your design or change the page
settings using the Page Setup dialog.

Using BarTender's Sample Documents
Because designing templates on your own may be time consuming, a number of standard
documents can be installed using the BarTender installation package. Any of these documents can
be modified to your own requirements. Oftentimes, you can even save time by modifying an existing
document; if one is close to what you're looking to design, then you do not need to start from
scratch.

Viewing the supplied documents in BarTender can also be an easy learning resource to discover the
many features and capabilities of the application. After you have loaded a document, you can
examine the various dialog settings to determine what features and customization options are
available.

To open a sample document
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1. From the File menu, select Open. Alternatively, click the icon on the main toolbar.

2. In the left Navigation Pane, select BarTender Documents. If this is not an option, browse to
the BarTender Documents folder ofMy Documents.

3. Locate the sample document you wish to open, located in the respective industry or category
folders.

4. Double-click on the desired document to open it in BarTender. Alternatively, click once on the
document name, then click the Open button.

To create a copy of a sample document

1. From the File menu, select New. Alternatively, click the icon on the main toolbar.

2. In the New Document Wizard, select Existing BarTender Document as your starting point.

3. Click the Select button.

4. In the left Navigation Pane, select BarTender Documents. If this is not an option, browse to
the BarTender Documents folder ofMy Documents.

5. Locate the sample document you wish to open, located in the respective industry or category
folders.

6. Double-click on the desired document. Alternatively, click once on the document name, then
click the Open button.

7. Click Finish to close the New Document Wizard and open the copy of the document in
BarTender.

Adding Objects to Your Design
Once you have a blank template (or design area) to work with, you can begin designing your items by
adding objects to it. BarTender includes the following object types:

Barcode: Select from hundreds of barcode symbologies and specifications using the Select
Barcode dialog, or select a recently used symbology from the list.

Text: Add a simple text object to your template, or specify formatted text by entering RTF,
HTML, or XAML code.

Line: Add a line to enhance the design of your items.

Shape: Select from a variety of shapes, including rectangles, arrows, polygons, and more.

Picture: Import a picture into your design from an existing file on your computer.

Encoder: Add a magnetic stripe, RFID tag, or smart code encoder to your item.

The process for adding objects to your design is the same for all types of objects.
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To add an object to your template

1. From the object toolbar, select the icon for the type of object you want to add. Alternatively,
select the object type from the Create menu.

2. Select your desired object from the sub-menu. For line objects, skip this step.

3. Click on the desired location to add the object. For line objects, click and drag to the desired
endpoint of the line.

Using Databases with BarTender
Many users store data, such as customer records or product information, in a file outside of
BarTender, such as an Excel spreadsheet, SQL database, or text file. If you want to use this data,
BarTender can pull the information directly into any barcode, text object, or encoder object on your
template. These external data files are collectively known as databases. This topic walks through the
steps needed to connect to a database and pull information into an object on your template.

To connect to a database

1. From the File menu, select Database Setup. Alternatively, click the icon on the main
toolbar. One of the following will occur:

l If you have not previously connected to a database, this will launch the Database
Setup Wizard.

l If you are currently connected to a database, this will open the Database Setup dialog.
Click the icon to launch the Database Setup Wizard.

2. On the initial page of the Database Setup Wizard, select the type of file your data is stored in.
Click Next.

3. Follow the wizard to complete the connection setup for the selected file type. At the end of the
wizard, click Finish to open the Database Setup dialog.

Once you are connected to a database, the information stored in the file can be used to populate
barcodes, text objects, or encoder objects on your template. The simplest way to pull in this
information is to use the Data Sources pane of the Toolbox.

To link an object to a database field

1. Select Data Sources in the Toolbox to display the Data Sources pane.

2. Expand Database Fields to show all available fields in your database.

3. Click and hold down on the desired database field.

4. Drag the database field to the desired barcode, text, or encoder object.

5. Release the mouse button.
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If the Live Database Navigator is enabled at the bottom of the design area, your data will be
displayed directly on your template. Otherwise, select Print Preview from the File menu to view your
data on your items.

Entering Data at Print-Time
In some cases, the data for one or more objects on your template might not be known until print-
time. Consider the following two examples:

l A standard shipping label which includes the weight of a package, but the weight of the
package is not known until print-time.

l A product label for perishable items for which you need to enter the current date each time
you print the label.

When you encounter this type of requirement, you can configure BarTender to display a data entry
form at the start of the print job where users can enter the necessary data.

To create and design a data entry form

1. At the bottom of the design area, click the tab Form 1 to open Form Design View.

2. From the object toolbar, select the icon for the control or object you want to add.
Alternatively, select the object type from the Create menu.

3. Select your desired control or object from the sub-menu. For line objects, skip this step.

4. Click on the desired location to add the control or object. For line objects, click and drag to the
desired endpoint of the line.

To link a control to a template object

1. In the Data Sources pane of the Toolbox, locate the data source whose text you want to enter
at print-time.

2. Click on that data source, and while holding the mouse button down, drag the data source
onto the desired control.

3. Release the button to link the control to the object or data source on your template.

To enter data into a form at print-time

1. From the File menu, select Print to open the Print dialog. Alternatively, click the icon on the
main toolbar.

2. Click Print to display the data entry form(s) for your document.

3. Fill out the data into the controls on your form. The data that you enter will appear on your
printed item at the location of the linked control.
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Printing Your Document
Once an item is designed, you are ready to print your document. Depending on how your production
environment is set up, you can print from a number of different applications in BarTender, as
described below:

To print your document from BarTender Designer

Each on-screen design area is configured to a specific printer. Since different printers
support different sizes ofmedia, changing your printer may affect the positioning of
objects on your items. If this occurs, you may need to modify your design to match the
new printer and media chosen before printing.

1. Open the document you wish to print.

2. From the File menu, select Print to open the Print dialog. Alternatively, click the icon on the
main toolbar.

3. Confirm that the correct printer is selected.

4. If you are connected to a database, verify that the Use Database check box is enabled.

5. For Copies, enter the number of copies you wish to print. If you are connected to a database,
this is the number of copies for each record in your database, and not the total number of
items that will print.

6. Click Print.

To print your document from Print Station

1. Open Print Station.

2. Browse to the document you wish to print.

3. Click once on the document. Depending on how Print Station is configured, this will either
initiate the print job or open the Print Document dialog.

4. If prompted, select the printer you'd like to use and enter the number of copies to print.

5. Click Print.

To print your document from Print Portal

1. Open Print Portal.

2. Browse to the document you wish to print.

3. Click once on the document. Depending on how Print Portal is configured, this may prompt you
to connect to a printer. In this case, follow the wizard until it displays the Print page.

4. On the Print page, select the printer you'd like to use and enter any other information.
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5. Click Print.

Clicking Print may do any of the following, depending on the setup of your document:

l Send the print job to the printer

l Open a data entry form
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For Administrators
While BarTender is fully functional once you install it, you can customize many of BarTender's
configuration settings to optimize the use of the application in your printing environment. As an
administrator of BarTender, you are responsible for managing licensing, configuring application
settings, and monitoring BarTender's performance. Essentially, it is up to you to customize
BarTender in a way that matches the needs of your company. This section is written to help you
locate the different administrative settings, and to intelligently set up BarTender for your printing
environment.

Managing Your Automation License
When running either the Automation or Enterprise Automation edition of BarTender, the application
must be able to communicate with Seagull License Server (SLS) to monitor printer licensing. Each
time a user prints, BarTender will scan the network attempting to connect to Seagull License Server
on the specified port.

One copy of SLS needs to be installed on your network to monitor printer usage and enforce
licensing. From SLS, you can track the number of printers in use, as well as trends in printer usage. In
addition, SLS can e-mail notifications or create a message log when your printer license is reached.

BarTender's connection to SLS is configured using the Licensing Setup dialog. If BarTender cannot
locate SLS on the network, verify the connection settings and test the connection using this dialog.

To manage Seagull License Server connection options

1. From the Administer menu, select Licensing Setup to open the corresponding dialog.

2. To use the default connection settings, enable Automatically Find Seagull License Server.
Otherwise, disable (uncheck) this option and manually enter the Server name or address
where SLS is installed.

3. In the Preferred section, modify the Port, Timeout, and Attempts settings.

4. Click Test to verify that the connection is working properly.

5. Click OK to close the dialog.

If Seagull License Server is running behind a network router or you have
a firewall enabled, enabling Automatically Find Seagull License Server
may not locate the server. If the connection test fails, manually enter
the network address into the Server field.

In the event that BarTender cannot connect to the preferred Seagull License Server, you can specify
the network location of another installed instance of SLS. The alternate SLSmust be installed and
activated independently of the preferred one, thus requiring the purchase of an additional software
license.
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Setting Up the BarTender System Database
The BarTender System Database is the central data storage for applications in the BarTender Suite.
It is required for most of the features included in the Automation and Enterprise Automation
editions. It includes data such as:

l Events encountered by any BarTender application (such as error messages and "pop up"
dialogs)

l Information about each print job sent from BarTender (such as the document that was
printed, along with the time the job was sent)

l Security checks defined in Administration Console

l Template designs and preview images (for reprinting items)

l Global data fields

l Librarian files and revision information

The default BarTender System Database uses Microsoft SQL Server Express, which is free but has a
10 GB database size limit. If you want multiple computers to share a centralized database, or if you
have a single computer logging a high volume of print jobs, you may want to use your own database
server.

The BarTender System Database Setup Wizard can be run from the BarTender installer, following
the installation of BarTender. If it was not installed at that time or if you wish to install another
BarTender System Database, you can run the wizard directly from Administration Console.

For more information on creating, administering, and maintaining the BarTender System Database,
refer to the System Database section of the BarTender help system.

Configuring BarTender Security
There are a number of security measures available in BarTender to help you protect your
documents, and to regulate your printing environment. Security in BarTender is highly customizable,
ranging from simple document protection to more complex user permission systems. Refer to the
BarTender System Security white paper for a comprehensive description of all available security
measures to help you decide which methods are most appropriate for your environment.

All of BarTender's security settings fall into one of two categories:

l Application-level security limits someone's ability to run or administer BarTender as an
application. For example, applying a "Print-Only Password" affects a user's ability to modify
every document in BarTender.

l Document-level security affects only a single document. These security settings are stored
with the document; therefore, moving the document to another computer will not affect the
document's security settings. Examples include defining a "Document Password" or encrypting
a document.
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Application-level Security

The following application security methods are available:

l Print-Only Password: A print-only password locks BarTender, so that without the
password, users have limited access to BarTender's design functionality. This is the
quickest security method to set up, but also the most easily defeated.

To define a Print-Only password

1. From the Administer menu, select Print-Only Password Setup to open the
corresponding dialog.

2. Enter and confirm the password.

3. Click OK.

l User Permissions: With Administration Console, a companion application to BarTender,
administrators can control user access for different actions across the BarTender Suite.
Specifically for BarTender, administrators can prevent users frommaking configuration
changes, modifying documents, or even printing.

To assign permissions using Administration Console

1. Open Administration Console.

2. In the Navigation Pane, click Security.

3. If needed, enable the check box Enable Security for this PC.

4. In the Navigation Pane, click User Permissions to open the User Permissions page.

5. At the bottom of Users and Groups, click Add to open the Add User or Group dialog.

6. Select the user you wish to add. You can refine the users and groups in the list by
selecting a Location or by entering search criteria, such as a user or group name.

7. Click OK to close the Add User or Group dialog.

8. With the newly added user or group selected in the Users and Groups pane, specify
the permissions you wish to allow or deny.

9. Click Apply to apply the settings. Click OK to apply the settings and close
Administration Console.

Document-level Security

The following document security methods are available:

l BarTender Document Password: A BarTender document password protects various
aspects of a document from all users who don't know the password. These protected
actions include opening the document, modifying the design, or changing VB scripts.
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Document passwords cannot be recovered if lost. That
means that, once you configure your document with a
document password, losing the associated password would
likely prevent you from using that document again.

To set up a BarTender document password

1. Open the BarTender document you wish to password protect.

2. From the File menu, select BarTender Document Password to open the
corresponding dialog.

3. Set the password and an optional password hint.

4. Under Protected Actions, enable (or check) the actions you want to password-
protect.

5. Click OK to close the dialog.

l Document Encryption: By enabling document encryption in Administration Console,
administrators prevent unauthorized users from accessing encrypted documents on
unsecured PCs. If an encrypted document is moved to a different PC, it cannot be opened
unless Administration Console is also installed and someone has defined the same key
used to encrypt the document.

To create an encryption key

1. Open Administration Console.

2. In the Navigation Pane, click Security.

3. If needed, enable the check box Enable Security for this PC.

4. In the Navigation Pane, click Encryption to open the Encryption page.

5. Click Add and enter the key of your choice, along with any comment you wish to
associate with it.

6. Click OK to close the dialog.

7. To automatically encrypt all documents in BarTender when you save them, enable
Encrypt documents when saving.

8. Click Apply to apply the settings. Click OK to apply the settings and close
Administration Console.

To encrypt existing documents

1. Open Administration Console.
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2. In the Navigation Pane, click Security.

3. If needed, enable the check box Enable Security for this PC.

4. In the Navigation Pane, click Encryption to open the Encryption page.

5. At the bottom of the Encryption page, click the Document Encryptor link to open the
BarTender Document Encryptor dialog.

6. Click the Add button to open Windows Explorer.

7. Browse to and select the desired document(s), then click Open.

8. In the BarTender Documents pane, highlight the document(s) that you want
encrypted.

9. Select the desired encryption key from the New Key dropdown list.

10. Click Encrypt Selected Documents Using New Key.

11. Click Close to close the Document Encryptor.

12. Click Apply to apply the settings. Click OK to apply the settings and close
Administration Console.

Changing the Language
BarTender is available in 23 languages, and provides on-demand switching of the user interface
between:

Chinese (Simplified and Traditional), Czech, Danish, Dutch, English, Finnish, French, German,
Greek, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese (European and
Brazilian), Russian, Spanish, Swedish, Thai, and Turkish.

By default, BarTender is installed in English, as well as the locale of your operating system. Additional
langauges can be added using the BarTender installer.

To install additional languages

This procedure assumes that you have already installed BarTender on your computer.

1. Double-click on the BarTender installation package.

2. On the initial installer screen, select Modify and click Next.

3. Enable the box for All Translations.

4. To complete the language installation, click Next.

5. Once installation is complete, click Finish to close the installer.

To change the language of the user interface

1. From the Tools menu, select User Preferences to open the corresponding dialog.
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2. Click the Regional Settings tab.

3. From the Language dropdown list, select the desired language.

4. Click OK to apply your settings and close the dialog.

Managing BarTender Files and Folders
As an administrator, you can specify where BarTender will store application specific files. You can
also set the default directories where BarTender will save and retrieve documents, images, and
scripts. If you are running the Enterprise Automation edition of BarTender, you can use Librarian for
file revision control and workflow.

The Folder and File Locations Setup dialog defines all of these locations, whether they're on your
local PC, somewhere on the network, or stored in Librarian. All of the defined locations can be
transferred between installed instances of BarTender. To save the current locations in an XML file,
select Export Locations and browse to the desired destination directory. Once saved, the XML file
can be loaded into another instance of BarTender using the Import Locations option.

To set a default file location

1. From the Administer menu, select Folder and File Locations Setup to open the
corresponding dialog.

2. Locate the folder or file location you wish to set.

3. Once highlighted, click the Select Location button.

4. Browse to the desired directory where you want BarTender to save and/or retrieve files. For
File Locations, also enter a file name for the configuration file.

5. Click OK to close both dialogs.

Using Librarian

Librarian allows you to store files in a centralized database rather than “loose” on various hard
drives, so files are easier to track and manage. File check-in and check-out prevents users from
overwriting each others' changes. You can use revision control to retain copies of all previous
versions of a file so that you not only have a history of who has made what changes and when,
but you can retrieve actual copies of the previous versions and even “rollback” to an older
version if desired. Librarian can be used with Security Center, letting you control which users can
access files within Librarian, and what they can do with them.

For more information, refer to the Librarian book of the BarTender help system.

Logging Application Messages
When you encounter a message, BarTender has the ability to log the message content and relevant
information about the occurrence to a text file or to the BarTender System Database. Examples of
these messages might include:
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l Save changes to Document1.btw?

l Although BarTender cannot connect to Seagull License Server, your BarTender will continue to
function normally for another 1 day(s). However, after this grace period ends, BarTender will
refuse to print or export printer code templates until a connection with Seagull License Server
is reestablished.

l No Data Sources Are Set To Be Serialized

You have specified a number of serialized templates but none of the data sources for any of
the objects are set to be serialized. To enable serialization for an object, see the Object
Properties dialog.

l Your printer does not support the page size specified in this document. You will be unable to
print until the page size settings are adjusted.

You can automatically adjust your page size settings using the closest possible settings, or you
can address the problem yourself later using the Page Setup dialog.

These messages may be purely informational, while others require that you make some sort of
modification to your document. When a message is logged, BarTender also saves relevant
information about the message, such as the time it occurred, the user's response, the message's
severity, and the computer in use. These logs can be viewed and audited at a later time to evaluate
BarTender's performance, or to identify common user error within the application.

To log application messages to the BarTender System Database

1. From the Administer menu, select Log Setup to open the corresponding dialog.

2. On the Database Log tab, enable Log To BarTender System Database.

3. If you are not currently connected to a BarTender System Database, click Setup to connect to
an existing one or to create a new one.

4. Under Information To Log, enable Application Messages.

5. From the Severity dropdown list, select the severity level of the messages you wish to log. If
you wish to manually select the messages to log, select Custom, then Select. Check the
desired messages, then click OK to return to the Log Setup dialog.

6. Click OK to close the Log Setup dialog.

You can view all messages logged to the BarTender System Database in History Explorer, one of the
companion applications included with the Automation and Enterprise Automation editions.

To log application messages to a text file

1. From the Administer menu, select Log Setup to open the corresponding dialog.

2. On the Text File Log tab, enable Log Messages.

3. Click the Setup button to open the Text File Log Message Setup dialog.
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4. For Log File Folder, enter the desired location where you want to save the log file.

5. To manually select the messages to log, click the Select button. Check the desired messages,
then click OK to return to the Text File Log Message Setup dialog.

6. Click OK to close both dialogs.

You can view the message log at any time from the Text File Log Message Setup or by browsing to
the location where the file is saved.

Sending E-mail Alerts
When BarTender generates an error or warningmessage, you can have an e-mail message delivered
to your inbox, notifying you of its occurrence. When setting up these alerts, many delivery formats are
available:

l Text Report: Each message encountered will appear as a separate line in this order: Date,
Time, Message Number, Message Type, Message Category, Response to Message, and
Message Body.

l Tab Delimited: Each message section is separated by a tab character.

l Comma Delimited: Each message section is separated by a comma.

l Quote and Comma Delimited: Each message section is enclosed in quotation marks, and
separated by a comma.

In order to receive alerts, you must first configure the outgoingmail server and specify one or more
recipients using the Alert Setup dialog.

To enable e-mail alerts

1. From the Administer menu, select Alert Setup to open the corresponding dialog.

2. On the E-Mail tab, check Enable E-Mail.

3. For Mail System select the e-mail protocol you wish you use to send the messages. Click
Setup to configure the outgoingmail server and to enter credentials, then click OK to return to
the Alert Setup dialog.

4. In the To field, enter one or more recipients for the alerts, separated by semi-colons.

5. For Output Type, select the desired delivery format.

6. To manually select the messages that will trigger a notification, click the Select Messages
button. Check the desired messages, then click OK to return to the Alert Setup dialog.

7. Click OK to close the Alert Setup dialog.
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Related Documentation
l Seagull Scientific Website

http://www.seagullscientific.com

l BarTender Support Center

http://support.seagullscientific.com

l BarTender Online Help System

http://help.seagullscientific.com

l Seagull White Papers

http://www.seagullscientific.com/support/white-papers
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